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INTRODUCTION

Purpose

This document describes how to develop and review steady state, dynamic, and short-circuit data used
to model Grant’s Planning Coordinator Area of the Transmission System in compliance with NERC
Standards MOD-032-1 and TPL-001-5. Grant Transmission Planners perform the case building process
through active participation in the WECC System Review Subcommittee, by following the guidelines in
the current-year WECC Data Preparation Manual, and by building cases described in the current-year
Base Case Compilation Schedule. The WECC case building process is coordinated regionally, and Grant
planners actively participate in the Area 40 coordination program currently facilitated through the
Northwest Power Pool.

The Transmission Planning group within GCPUD functions as both the Planning Coordinator and
Transmission Planner in the creation and upkeep of these modeling data requirements and reporting
procedures (MOD-032-1, R1).

Effective Date:
March 1, 2022



DATA REQUIREMENTS

Data Required and Level of detail (R1.1, R1.2.2)

The level of detail for each type of facility must adhere to the guidelines as described within the current-
year revision of the WECC Data Preparation Manual, which is a super-set of data described in MOD-032-
1, Attachment 1.

Data format (R1.2.1, R2)

The development of power system models is based on data collected from each Balancing Authority,
Generator Owner, Resource Planner, Transmission Owner, Load Serving Entity, and Transmission Service
Provider within the District’s Planning Coordinator Area. For GCPUD facilities, GCPUD Transmission
Planning acts as all functional entities mentioned in R2. The following options are available for
submitting data:

e Provide data within PowerWorld .pwb or .aux file formats
e Tabulated spreadsheet (pre-populated tables from previous submittals can be provided)

Case types/scenarios (R1.2.3)
Various case types and scenarios are developed for each calendar year according to the current-year
WECC Base Case Compilation Schedule (BCCS). The BCCS typically includes the following base cases:

e Five operation cases

e Two specialized cases

e One 5-year summer planning case
e One 5-year winter planning case

e One 10-year summer planning case
e One 10-year winter planning case

REPORTING PROCEDURE

Point of Contact (R2)
Applicable entities within the District’s Planning Coordinator Area shall submit documentation, data, and
associated correspondence to the following email address:TransmissionPlanning@gcpud.org

Annual Update (R1.2.4)
Data shall be submitted by each applicable entity within the third calendar quarter of each year.

Distribution and Posting (R1.3)
This Data for Power System Modeling and Analysis document is posted on the District’s public web page
within the Transmission Information section.

Coordination with WECC Case Building Process (R4)

Grant coordinates case building with WECC (ERO) through a General Services Agreement established
with the Northwest Power Pool — now the Western Power Pool (WPP) — for Area 40 coordination. WPP
receives case building communications from WECC, leads the review process for Area 40 participants,
provides an ftp repository for downloading and uploading base cases, and submits completed cases back
to WECC once approved by the Area 40 participants.


mailto:TransmissionPlanning@gcpud.org
https://www.grantpud.org/transmission-information

MANAGING THE PROCESS

In general, Microsoft OneNote is used to document the review process, working files are held on the
user’s PC, and when the case review is completed, the working folders on the user’s PC are uploaded to
the WECC Case Building archive on the corporate drive.

Grant Files

All WECC case building documents are stored on a corporate drive at:
S:\Depts\TSSystemsEngineering\Transmission Planning\WECC Case Building. This folder includes a
Microsoft OneNote document used to write notes generated during case reviews. The folder also
contains calendar-year folders holding all base case development files downloaded and uploaded
to/from the WPP ftp site with a structure generally mimicking the structure found on the WPP site.

WPP Files

Grant Planning engineers working on base case development will need to request ftp access from the
WPP for the purpose of Area 40 coordination. The site provides a centralized location used to participate
in the WECC case building process.

Due Dates

A good practice for the case building engineer is to enter due dates into Outlook before the beginning of
each cycle. Dates needing a response from GCPUD are given at the start of each build season in the BCCS
document. The schedule for the 2022 cycle is shown for example in Figure 1.

2022 Base Case Compilation Schedule

Date Data Date Area Date Area
Date Data Date Data . WECC Staff | Date Comments| Coordinator WECC Staff
Due to Sub- Coordinator L
Case Request . Due to Area Send Case for| Due to Area |Comments Due Finalize
. Coordinate . Due to . .
Mailed L&R Info Coordinator WECC Staff Review Coordinator to Date
WECC Staff

2022 1.5P25* 4/23/21 - 5/14/21 6/11/21 7/2/21 7/23/21 8/6/21 §/20/21
2025 HS358* 6/25/21 - 7/16/21 8/13/21 9/3/21 9/17/21 10/1/21 10/15/21
2022 HS3S 7/23/21 - - - 8/20/21 9/17/21 10/15/21
2033 LSP1S 9/17/21 10/1/21 10/8/21 10/29/21 11/19/21 12/10/21 1/7/22 1/28/22
2022-23 HW3-OP

10/15/21 11/5/21 11/12/21 12/10/21 1/7/22 2/4/22 2/25/22 3/25/22
2022-23TWI-OP
2023 HSP1-OP 11/12/21 12/3/21 12/10/21 1/7/22 2/4/22 2/25/22 3/18/22 4/8/22
202728 HW?2

12/10/21 12/31/21 1/7/22 2/4/22 2/25/22 3/18/22 4/8/22 5/6/22
2028 HS2
2023 HS4 0P

3/18/22 4/8/22 4/15/22 5/13/22 6/10/22 7/1/22 7/22/22 8/12/22
20231.51-0OP
2032-33 HW1

4/15/22 5/6/22 5/13/22 6/10/22 7/1/22 7/22/22 8/12/22 9/2/22
2033 HS1

Figure 1: Example BCCS Schedule

Important due dates for Outlook are given for each case in columns four and seven, which are the dates
GCPUD review files are due to be uploaded to the corresponding folders at the WPP ftp site. Column
four dates indicate when Pre-run review files are due, and column seven dates indicate when Review

files are due.



file://ephw16dfsfs01.gcpud.org/fs/Depts/TDSystemsEngineering/Transmission%20Planning/WECC%20Case%20Building
onenote://S:/Depts/TDSystemsEngineering/Transmission%20Planning/WECC%20Case%20Building

REVIEWING THE CASE

Download Case for Review
1. Create a local file structure to store working files.

2.

Login to the WPP ftp site using FileZilla (available in Software Center) and navigate to the case
shows an example for the location of Pre-run files for the 28
Heavy Summer season. Pre-run cases are currently located in the Seed Case folder within the
onal scenario. Review cases can be found in the WECC Review

under consideration. Figure 2

Initial Case folder for the seas
Case folder under the Review

Case folder just a bit below the Initial Case folder.

Remote site: | FRTATPS Aread )/ NWPP_AADC2022BaseCases/ 07 28H52/01 Initial Case/01-1 Seed Caze

o-[ ] 011
&

..... 2 02 33L5P1S

..... 2. 03 2022-23HW3-0P
..... 2 (4 2022-23LW1-0P
..... 92 05 23HSP1-0P

..... 2 06 2027-28HW2
& | 07 28Hs2

nitial Case

01-1 Seed Case

? Archive

01-2 Initial Member Files
01-3 Pre-run Caze

01-4 Pre-run Member Files
M5 Imitial Soidrmaittal Einal

Double-clicking on the Seed Case folder reveals all the files in the folder and shows them in the
pane below as shown in Figure 3. The left side of the display shows the users local file system
which should be prepared to download case files. Double-clicking each file from the right-side

panel downloads the file into

Figure 2: WPP ftp Site Structure

the file location shown on the left-hand panel.




Local site: | rant County PUD\Decuments\WECC Case Building\2022407 28 HS\Pre-run',

Remote site: | TPS/Areadl/NWPP_ALDC/2022BaseCases/07 28H52/01 Initial Case/01-1 Seed Case ~

Empty directory.

5files and 1 directory. Total size: 91,911,577 bytes

- 0122H535-5ADD ~ -2, 03 2022-23HW3-0P ~
@~ 0233L5P -2, 04 2022-23LW1-0P
- 0323 HW -7, 03 23H5P1-0OP
- 0423 LW -2, 06 2027-28HW2
- 0523Hsp = | 07 28HS2
- | 0628 HW : 01 Initial Case
a- 07 28 HS .. 01-1 Seed Case
m (2] Archive
- 08 23 HS ? 01-2 Initial Member Files
- 0923LS -2, 01-3 Pre-run Case
1033 HW %, 01-4 Pre-run Member Files
11322 Hs M H 2, 01-5 Initial Submittal Final
€ > h N7 Ranvians Cara &
Filename Filesize Filetyp | Filename Filesize Filetype
Archive File folde|
|| 27THS2a1-Map.pwd 13,096,490 PWD File
ﬂ 27HS2a1-SADD xlsx 4,977,263 XLSX File
E?HSZE'I-Updated-BA-CustomColumns.pwb 29,536,261 PowerWo|
Z?HSZE'I-UpdatEd-BA.pwb 29,523,897 PowerWo
: 27THS2a1PW zip 14,777,666 Compres:
< > |« >

4. Extract the included zip file to open the ASMAT pdf used in the following steps.

Figure 3: Case File Location

Create a OneNote Entry for the Current Review Case
NOTE: The OneNote file is stored on the corporate drive, so you need to be onsite or connected via the

vpn for access. If using the vpn, note that FileZilla will often not connect to WPP, and

downloading/uploading to WPP requires the vpn be disconnected.

1. Open the WECC Case Building OneNote and navigate to the current calendar year. If this is the
first case in a new cycle, create a new Section for the coming year.
2. Create a new Page for the case under review and create a Subpage for Pre-run and a Subpage
for Review as depicted in Figure 4.

07 28 HW

|- add Page

B
05 23 HEP

Pre-rum

B

Figure 4: OneNote Entry



onenote://S:/Depts/TDSystemsEngineering/Transmission%20Planning/WECC%20Case%20Building

3. Print the Case Summary Sheet page from the ASMAT file to OneNote, directing the print to the
case main page, which should result in the page looking like that in Figure 5 for the 2023 Heavy
Spring case. This provides summary information for the case under review.

£, I\'-\'V[E:C:Cc.:c;‘:sniilﬂ;uc:l%nc-.e *5 | 022 4 S o
- Add Page
05 23 HSP

anday, December 4, 2041

Schedule
Process Steps
01 2535 SADD
Rearwe
oBLP
Pre-run
Review
033 Hianey Wanber
Pre.mun

Case sSummary Sheal Review

2022 Heavy Spring 1 Operating Base Case 4 73 Light Winker
Purpate: OPERATING CASE - TO REPRESENT ANTICIPATED OPERATING CONDITIONS WITH Pre-nm
HIGH FLOWS FROM NORTHWEST TO CALIFORNIA. eiten
Loads: Expected peak 1oad for the monshs of March - May 0523 5P
Time: 1600 - 2000 hoties MST. Precrm

Figure 5: Case Summary Sheet to OneNote

4. Use the Pre-run and Review subpages for review notes. An option for use is to copy all emails
associated with the review cycle to this page, as shown for example Figure 6.
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SonedBm e | 00 "5 [
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o e
Summary of Owner Objects
e Review
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Load and Generaton Pre-un
T e Revew
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Nevember 12, 2021 Sy 02600 [em
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Figure 6: Email and Notes in OneNote

Check the Case
1. Open PowerWorld and open the current Grant Master case. The Master case is located on the
corporate drive as shown in the example of Figure 7 for the 2021-year process.

NOTE: it is very useful to download a copy of the Master case folder to the users C drive as
the files in this folder are referenced often during the process, and this allows the user to
disconnect the vpn which can make life much better.



[ + | Master Transmission Model - O x

Home Share View o

»*

l_‘l 4 Cut x Li__Thr\le\ar\tern' @ Open ESe\e:tall

w.. Copy path Tj Easy access ~ Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename Mew Properties
e [7] Paste shortcut g e o folder o % History 5 Invert selection
Clipboard Organize New Open Select
<« A <« Depts » TDSystemsEngineering » Transmission Planning » 2021 » Master Transmission Model v | D L Search Master Transmission ..
~
PnC Development + MName Date medified Type Size
Recruiting * Archive File folder
Relay Settings * Au Files File folder
Standards - Docs File folder
SUB - Load Forecast File folder
Transmission Planning - [ 2021 Oneline.pwd PWD File
TDSystemsEngineering * Grant MASTER Case.pwb PowerWorld Binary
[} PWD Oneline 2021 ML.pwd PWD File

Template Package Record Revl =
emplate Package Record Rev * | ReadMetxt Text Document
'WECC Case Building *
Work -+
WsU *

@ OneDrive - Grant County PUD

Figure 7: File Location of Master Model

Navigate to the Owner tab, right-click on Grant PUD, and select Show Dialogue. Screen grab the
dispatch and objects section and paste in the OneNote page. This provides a simple display of
before/after condition of the case.

Establish the Difference Case by navigating to the Tools menu, selecting the Difference Case
icon, and clicking the Set Present as Base item. This saves the Master case parameters into
memory. It does not matter that the Master case has a certain generation and load dispatch
inherited from whatever seasonal case was used to create the master as we are only concerned
at this stage with the accuracy of the system topology. Gen and load dispatch is set/verified in a
later step.

W pHESRE FH System Scaling - Case: Grant MASTER Case.pwb Status: Initialized | Simulator 22
File Casenformation  Draw  Onelines  Tools  Options  AddOns  Window -
(X) Abort ] i ot 47 Eault Analysis v % == Equivalending v
Edit Mode ot ,,x 4 A @ d’;‘ o . iy A &" & ) :
Eog Solve v £ T <7 (£ Time Step Simulation > X Other v | Modify Case
Run Mode Solve Power  Simulatar Contingeney  CTG Combo  RAS = (TG Sensitivities Limit Difference  Srale  Model  Connections
W script v Fiow -Mewton Options ~ ReEstore v Analysis Analysis  Case Info~ ~ Ling Loading Replicator  pgnitaring Case~ | Case  Explorer ~ Renumber
Mode Log Pouwer Flow Taols Run Mode % Difference Case... Edit Mode
Object Type to Scale By

Present Topological Differences From Base

Bus  Area Zone Owner Injection Group

Set Present as Base

Select Buses to be Scaled

Clear Base Case

Add to Scaling Buses (fitered) Areas Zones Super Areas Set Present as Base
= : = Key Field Type [Prima -
Areas P Bl 8 4% B4 M T Records~ Geor Set~ Columns~ - M3- WS- P OBH- W - F opt v Field ype v
Zones
Number vame | scaler ' Present Mode
Buses 1 125T_TA NO Base Mode
Remove from Scaling :oooms jt . :jg Difference Mode
Areas _ a 10006 ALIRE_T NO Change Mode
2 10007 ALLISONE  NO
anes G 10008 ALLISON NO Show Present|Base in Differance and Change
Buses 7] 10009 ALLISONT  NO

Change Mode Tolerances

»

10M0 SMERNSIE MO

v

Note: Scaling is dane on the BUSES chosen regardless of the area or zone specification. Options for Areas, Zones, and Super Areas are induded only to aid in selecting and unselecting blocks of buses to be scaled, This is important if loads or generators are assigned to a different arez or zone
than ther terminal bus.

4.
5.

Without closing PowerWorld, go to the File menu and open the case under review.

Go back to the Tools/Difference Case icon, and this time select Present Topological Differences
from Base... This step displays all the changes it would take to update the current case topology
to match the Master case topology.

Create the Difference .aux file by navigating to the bottom of the Difference tool window and
selecting Save To then Complete Model.

Set the options as shown in Figure 8 and select OK. The Master case filters and Aux File Export
are set to limit the export items to those owned by Grant.




10.

11.

12.

13.

14.

15.

16.
17.

Confirm Options X

What to Save Filtering of Objects

(®) all Lists () None (All objects)

() Only Mew Elements () Use Both Area/Zone/Owner and Data Maintainer Filters
() Only Removed Elements (®) Uze Only Area/Zone/Owner Filters

() only Both Elements () Use Only Data Maintainer Filters

u Assume base Areas/Zones/Cwners and Data Maintainers that are not in present case meet the
filters

Edit Area/Zone/COwner Filters and Data Maintainer Filters

Indude ClearPowerFlowSaolutionAidvalues Script Command

Choose ALY Export
Format Description

User; Topo Only i ~ | | Define Formats

K Cancel

Figure 8: Difference Save Options

Open the aux file for editing in Notepad++ (available in Software Center), and delete the
following lines:

a. Delete the Owner sections in both the New and Removed sections of the aux file

b. Delete the Data Maintainer sections in the New and Removed sections

c. Look for any non-Grant topology mentioned in the New and Removed sections.

d. It can be helpful to have PowerWorld open in one monitor and the aux file opened in

another for easy cross-referencing as one edits the aux.

Save the aux file using a format like 28HS Grant Pre-run Update.
Set the required seasonal load dispatch using the current load forecasting process, adding the
appropriate aux file syntax to the end of the update file.
Set the required seasonal generation dispatch by copy/paste using the generation dispatch aux
file syntax within the dispatch files located in the Master case directory in the Aux
Files/Generation folder.
Open the review case and load the update aux file, checking the log for any errors during the
load and then during a solve.
Check overall topology by loading the Master case oneline, switching to Edit mode and looking
for any facilities in Pink, meaning the facility drawn on the oneline is not actually in the case.
Run Contingency Analysis using all but P3 & P6 outage definitions to check for any Grant
violations.
Login to the WPP ftp site and upload the newly created update aux file to the appropriate folder
within the GCPUD structure. WPP looks in these folders for all case updates.
Copy the local case building folder to the corporate drive for archive.
Make any final notes in the OneNote page, and you are finished.
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